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U.S. Payroll Tax Tables—June 2014 Updates
Government-Mandated Payroll Tax Changes
As a result of legislative changes, the payroll tax tables changed for the following jurisdictions, effective April 1, 2014:

l Wisconsin
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Enhancements in Version 19.3
Youwill find the following new features and enhancements in Sage 100 Contractor Version 19.3.

Integration with Sage Payment Solutions
Sage 100 Contractor now integrates seamlessly with Sage Payment Solutions.

Using Sage Payment Solutions with Sage 100 Contractor saves you time, helps you get paid faster, and eliminates the
need to enter payment information twice. Simply enter your customer's card payment details once in Sage 100 Contractor,
and the payment will be processed in Sage 100 Contractor and Sage Payment Solutions, in one easy step.

With the integration between Sage 100 Contractor and Sage Payment Solutions, you can process credit card transactions
without storing your customers’ sensitive card information in your database. Sage Exchange transmits credit card details
through a secure connection to Sage Payment Solutions, where they are stored in a PCI-compliant vault, protecting you
from exposure to non-compliance penalties and credit card fraud.

NOTE: In the U.S. edition, you can also process ACH checks electronically through Sage Payment Solutions, while
protecting your customers' banking information.

In addition to providing integrated payment processing, Sage Payment Solutions also offers gift and loyalty card programs,
merchant cash advances and loans, non-profit and healthcare payment solutions, andmore.

To learnmore about Sage Payment Solutions, visit http://na.sage.com/us/sage-payment-solutions.

Related changes in Sage 100 Contractor windows
Wehave updated several Sage 100 Contractor windows to support electronic receipt processing.

7-2 Company Information

Wehave added new options and added a tab in the 7-2 Company Informationwindow:

l You use the new Electronics Receipts Setup tab to specify your merchant ID andmerchant key. Sage sends you
these credentials when you purchase a Sage Payment Solutions account.

This tab contains additional fields that determine how Sage 100 Contractor interacts with Sage Payment Solutions:

l Posting Cash Account. You enter the ledger account for the bank account connected to your Merchant ID.

l Allow client credit card and bank account information to be securely stored in the Sage Exchange
Vault in the U.S. Edition.

l Allow client credit card information to be securely stored in the Sage Exchange Vault in the
Canadian Edition.

Storing sensitive client information in the Sage Exchange Vault allows you to reuse this information in electronic
receipt transactions without storing it in your company database. Sage Exchange uses the last credit card (or bank
account) number used for the client, or you can enter a different number when you process an electronic receipt.

http://na.sage.com/us/sage-payment-solutions
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NOTE: If you select the company option to store client information in the vault, you can always override the
option for individual customers in the client record, if necessary.

3-6 Receivable Clients

Wehave added a new option, renamed some options, and renamed a tab in 3-6 Receivable Clientswindow:

l ThePayment and Billing tab is now calledBilling and Payment.

l A new option appears on theBilling and Payment tab that lets you override the company option for storing client
information.

If you use the U.S. edition, you can select Do not use the Sage Exchange Vault to store credit card and bank
account information.

If you use the Canadian edition, you can select Do not use the Sage Exchange Vault to store credit card
information.

l Fields that used to be labeled for credit card information in older versions have been renamedReference 1,
Reference 2, Reference 3, andReference Date.

IMPORTANT: If you have been using these fields to store credit card information, we strongly recommend
that you remove that information from these fields.

New 3-3-2 Electronic Receipts

You use the new 3-3-2 Electronic Receiptswindow to process credit card receipts electronically, or to post a receipt
manually that was entered through a third-party website. There is also a corresponding new 3-3-2 Electronic Receipts
report.

NOTE: In the U.S. edition, you also use this window to process ACH checks electronically.

IMPORTANT: Before you can process receipts electronically, you need to set up amerchant account with Sage
Payment Solutions. Then, youmust enter your merchant ID, merchant key, and bank account number in the 7-2
Company Informationwindow.

The 3-3-2 Electronic Receiptswindow is very similar to the 3-3-1 Cash Receiptswindow, with a few notable differences:

l You process an electronic receipt for one client at a time. Therefore:

l You need to enter only the Client number in the transaction header.

l You display invoices for the selected client in the grid.

Alternatively, you can enter an invoice number and let Sage 100 Contractor fill in the client information for
you.

l If you selected the company option to store client information in the Sage Exchange Vault, the following check
boxes appear:

l Save payment information lets you save payment information that you enter for this transaction and client
securely in the Sage Exchange Vault—not in your Sage 100 Contractor company files.

If you choose to store credit card or bank account information in the vault, you enter this information when
you process an electronic receipt for a client. This information is stored anonymously in the Sage Exchange
Vault along with a vault ID that is returned to Sage 100 Contractor.
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Only the vault ID is associated with the client record in Sage 100 Contractor. The next time you process an
electronic receipt for that client, Sage Exchange uses the vault ID to identify the last credit card or bank
account number used for the client, or you can enter a different credit card or bank account number.

l Use last payment method is available if you processed a payment for the client previously. If you select
this option, Sage 100 Contractor sends a reference key to Sage Exchange so that you can reuse the client's
secure payment information from the Sage Exchange Vault.

l TheOptionsmenu includes two new options:

l Process and Post—to process the receipt electronically through Sage Payment Solutions, where it will be
deposited to your bank account, and post the transaction to your Sage 100 Contractor General Ledger.

l Post—to post a transaction to your Sage 100 Contractor General Ledger that you entered directly through the
Sage Virtual Terminal or using another payment processing service.

When you use the Post option, a separateElectronic Receiptwindow appears, where you enter details
about the receipt, including the date, reference number, payer's name, the last four digits of the deposit
account number, and the type of credit card used. In the U.S. edition, you can also select ACH as the
payment type.

l There are new Process and Post andPost buttons that perform the same functions as their counterparts on the
Options menu.

When you submit the electronic receipt to Sage Payment Solutions, a Sage Exchange integration window appears, where
you can proceed with payment (entering credit card or bank account information as needed), cancel the payment, or change
payment card details or banking information.

3-3-1 Cash Receipts

The 3-3 Cash Receiptswindow is now called 3-3-1 Cash Receipts, and the Cash Receipts report has also been renamed
accordingly.

11-2 Work Orders/Invoices/Credits
Fields that used to be labeled for credit card information in older versions have been renamed Reference 2, Reference 3,
and Ref Date.

IMPORTANT: If you have been using these fields to store credit card information in the past, we strongly
recommend that you remove that information from these fields.

1-3 Journal Transactions

TheOptionsmenu in the 1-3 Journal Transactionswindow includes a new View Electronic Receipt selection, which is
available when you display an electronic receipt.

When you click View Electronic Receipt, a separate Electronic Receipt window appears, where you can:

l View the details that were posted with the electronic receipt in Sage 100 Contractor.

l View details of voided or credited electronic receipts.

l Print a hard copy of the receipt.

In the 1-3 Journal Transactionswindow, you can also void an electronic receipt that has not been settled in Sage
Exchange using the Void Transaction option on the Edit menu.
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NOTE: You can void an electronic receipt that has not been settled in Sage Exchange. If it has been settled and you
proceed to void the transaction in Sage 100 Contractor, the program will attempt to create a credit transaction in Sage
Exchange. If it cannot create the credit transaction, youmust log on to Sage Exchange to correct the receipt
manually.

Drag Excel, Word, and other documents to the Desktop
When editing shortcuts, you can drag various types of documents, including Excel, Word, and PDF documents, and drop
them on the Sage 100 Contractor Desktop, where you can easily open them without minimizing Sage 100 Contractor.

To open a document in the associated program, you simply double-click its icon on the activity center desktop. You do not
have to leave Sage 100 Contractor to hunt for and open documents you use regularly for reference!

TIPS:
l While you cannot drop URLs directly on the Desktop, you can copy a bookmark from your browser, save it as a

shortcut on yourWindows desktop, and then drag the shortcut to the Sage 100 Contractor Desktop. You can
view the website in your default browser simply by double-clicking the shortcut.

Make sure you do not delete the shortcut from yourWindows desktop, or the shortcut on the Sage 100
Contractor Desktop will not work.

l You can also drag folders fromWindows Explorer, and drop them on the Desktop.

l As a best practice: On yourWindows desktop, create a folder called "Sage 100 Contractor Shortcuts," and
then save shortcuts to that folder before dragging them to the Sage 100 Contractor desktop. Storing all your
Sage 100 Contractor shortcuts in one place will help you stay organized andmay serve as a reminder not to
delete them.

NOTE: Similar to shortcuts you create for Sage 100 Contractor windows and reports, youmust select Click here to
edit your shortcuts before you can drop documents on the Desktop. In edit mode, you can also rename the icons.
However, you cannot link icons for external documents to process flows.

Service Attachments
Sage 100 Contractor now accepts attachments sent with service work orders from third-party applications, and allows
third-party developers access to attachments that are included with Sage 100 Contractor work orders.

Documents and pictures sent as attachments are copied to a local Attachments folder (such as C:\mb7\'company
name'\Attachments\Clients\Service Invoices).

When you view work orders in the 11-2 Work Orders/Invoices/Creditswindow, you can open and view the attachments
as you would an attachment you added directly in Sage 100 Contractor.

Also, when you query work orders, the results include details for any attachments.

Reversing Payroll costs to a different period than the original
transaction
When posting a reversing entry for a voided payroll transaction to a different period than the original transaction, Sage 100
Contractor does not void the original job costs. Instead, the job costs are reversed in the same period as the payroll
reversal.

In this way, job costs always match the posted general ledger transactions, preserving the job-costs-to-general-ledger
balance.
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Other enhancements in this version
Sage 100 Contractor Version 19.3 includes the following enhancements to the U.S. Edition:

n There is additional help for the 5-2-4 Payroll Checkswindow when printing check stubs for direct deposits. If an
employee is set up for emailing, you receive amessage asking whether you want to email the deposit at this time. Now,
when you click theHelp button, the program displays a topic that clarifies this choice and explains how you could email
the check stub later. We recommend that you click Yes to email the check when you print direct deposit checks.

n The 5-2-2 Payroll Recordswindow and the 5-5-1 Daily Payroll Entrywindow now warn you if you try to save a
timecard that uses a voided service order number.

n When recalculating balances in the 1-6 Period/Fiscal Year Managementwindow, the check for duplicate records runs
only once.

n Vendor 1099 (or T5018) reports you print using the 4-1-1-61 Vendor Listmenu now show the 1099 (or T5018) total
amount from the ledger. Also, the report now includes a Tax ID column.

n Vendor 1099 (or T5018) reports you print using the 4-1-5-61 Vendor Payment Journalmenu now include a Payment
Amount column, and you can filter the report by 1099 (or T5018) type.

n The help topic "About setting up payroll calculations for paygroup benefit packages" now explains why you should not
use certain calculationmethods. (Reports exclude benefits that use the 2-%Total Taxable Wages, 10-Per Day, 11-Per
Pay Period, 17-Tables, and 18-Variable calculationmethods.)

n Wehave updated the links on the Home and Resources tab, as follows:

p You now enter enhancement requests for Sage 100 Contractor on a new web page when you click Customer
Resources > Product Enhancement Requests.

NOTE: You do not need to re-enter enhancements you requested before. We still have them!

p For information about Sage 100 Contractor, you now click Customer Resources >MySage.

p TheCustomer Resources > Contact Us link now takes you to a fresh, new web page that provides a variety of ways
for you to contact us.

Enhancements for the U.S. Edition
Sage 100 Contractor Version 19.3 includes the following enhancements to the U.S. Edition:

Additional U.S. State Certified Reports
Does your company perform work on government-funded construction projects?

FormWH-347 and state certified reports are available through our integration with Aatrix. Properly filled out, this form
satisfies the requirements of Regulations, Parts 3 and 5 (29 C.F.R., Subtitle A) as to weekly payrolls submitted in
connection with contracts subject to the Davis-Bacon and related Acts.

Besides the U.S. Federal report, which was available in Version 19.2, state certified reports are now available for the
following states (an asterisk indicates a new report for Version 19.3):

l Alabama*

l Alaska

l Arizona*
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l Arkansas*

l California

l Colorado

l Connecticut*

l Delaware*

l Florida*

l Georgia

l Hawaii*

l Idaho*

l Illinois

l Indiana*

l Iowa*

l Kansas*

l Kentucky*

l Louisiana*

l Maine*

l Maryland*

l Massachusetts*

l Michigan

l Minnesota*

l Mississippi*

l Missouri*

l Montana*

l Nebraska *

l Nevada*

l New Hampshire*

l New Jersey

l New Mexico*

l New York

l North Carolina

l North Dakota*

l Ohio*

l Oklahoma*

l Oregon*



- 9 -

l Pennsylvania

l Rhode Island*

l South Carolina*

l South Dakota*

l Tennessee*

l Texas*

l Utah*

l Vermont*

l Virginia*

l West Virginia*

l Wisconsin*

l Wyoming*
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Fixes in Version 19.3
Wehavemade the following software fixes in the first release of Version 19.3.

n When you set the Phase field in the 4-2 Invoiceswindow to skip during entry, the program correctly skips that field when
you enter an order number.

n An ineffective option to save default settings no longer appears on grid-printing screens. TheDefaultsmenu appears in
regular print windows, where you can save printing defaults.

n When you print Job Contact List reports after deleting contact information in the 3-5 Jobswindow, the long name for the
job no longer appears inappropriately at the top or the bottom of the report.

n When you enter a paid Accounts Payable invoice that includes a job, if you click theAutomatically job cost upon save
icon, you receive a reminder that paid entries will not be posted to the general ledger or to job costs.

NOTE: When you post a new invoice with a Paid status, you cannot automatically cost jobs or create
payments. Only the invoice entry is saved.

n When entering recurring payables (in the 4-6 Recurring Payableswindow) or recurring receivables (in the 3-11
Recurring Receivables window) you are no longer required to enter discount terms or due terms.

n When posting a large number of service contracts in the 11-2 Work Orders/Invoices/Creditswindow, you no longer
receive amessage asking you to change their priority on the dispatch board.

n In the 5-2-6 Post Payroll to GLwindow, if you reverse a payroll record rather than void it, the associated job and
equipment cost records are left intact to match the original GL transaction. When you post the reversal to the ledger a
new set of cost records is created tomatch the reversing transaction. This treatment maintains the balance between the
General Ledger and the Job Costs-To-General Ledger balance, even if the reversed record is posted to a different
period than the original record.

n To prevent the truncation of attachment file names, Sage 100 Contractor now ensures that attachments use files names
no longer than 100 characters. Attachment descriptions can now use up to 100 characters, whereas previously they were
limited to 75 characters. Temporary backup files are now saved in the Sage 100 Contractor ProgramData folder.

n When printing a consolidated financial report in the 2-8 Financial Reportswindow, you can select only companies that
have the specified reporting year and period.

n In the 10-3 Scheduleswindow, we have changed theUse Company Calendar during Calculation option to readAdd
off days from company calendar to make the purpose of this optionmore clear. (The option functions the same as in
earlier versions.)

n Wehave improved the performance of the 2-3 Income Statement report printing window when printing statements that
include subaccounts. It now takes significantly less time to print the 2-3-41, 2-3-51, 2-3-53, and 2-3-71 reports than in
Version 19.2.

n The ArchiveWizard (in the 1-6 Period and Fiscal year Managementwindow) now updates the progress bar more
smoothly when removing data, indicating that the archive process is still running.

n When you enter an invoice for a vendor that uses the 15th of themonth as due terms, the 4-2 Accounts Payable
window now assigns the correct due date nomatter which day of themonth you enter the invoice.

n Appointments you create for clients in the 3-6 Receivable Clientswindow are now properly saved to the calendar and
the client record. Any existing appointments are retained, and only appointments you delete are removed.
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n You can now search by vendor namewhen you run queries in the 4-2 Payable Invoices/Creditswindow.

n In the 9-5 Takeoffswindow, you no longer receive an "Unhandled Exception" error message when you export change
orders by Job/Phase

n Wehave restored the Save Current Grid View option in the 9-5 Takeoffs window.

n Posting payroll to General Ledger is much faster than in Version 19.2.

n In the 5-2-1 Employeeswindow, the Direct Deposit Rate Type is now saved correctly in new and existing employee
records.

n Checks entered with a void status in the 1-1 Checks/Bank Chargeswindow use the correct format for the posting
period and appear correctly on the check register.

n When archiving a company that uses a LIFO or FIFO inventory method, the program now properly validates the archive
folder. Inventory balances for future years are not included in the archive.

n The 2-2-31 Balance Sheet report now shows the correct Retained Earnings balance for the previous year after you
archive the previous year.

n When you generate a 2-9-21 Statement of Cash Flows report in period 1 of a new year, the Increase in Equity amount
shown on the report is now correct.

n In the 6-2 Budgets, 6-9 Proposals, and 6-10 Unitary Proposalswindows, when you create a new proposal by
importing the budget from another job, the window displays the job for the new proposal.

n When you customize Aatrix forms in the 5-3-9 HR Formswindow, you can now edit text fields.

n If your company name includes special characters (such as "&"), you can now email pay stubs when you generate
payroll checks for direct deposit in the 5-2-4 Payroll Checks report printing window. The program now inserts an
underscore in the PDF file name to prevent an error.

n In the 1-9 Company Departmentswindow, you can now save a new Service Receivables Type if the department uses
the same number as a dedicated account.

n The 5-1-5-21 Workers Comp report no longer displays rounding differences in the overtime column.

n Notes are now saved to the current company folder by default, although you can save notes to a different location when
you use the Save As function.

n When you enter multiple receipts in the 4-7-3 Enter Credit Card Receipts window, the cursor now always moves to the
first empty field after you save.

n In the 6-6-1 Purchase Orderswindow and the 9-5 Takeoffswindow, when you select rows and columns in the grid, the
visual display shows your exact selection.

n The 10-3 Scheduleswindow now displays amessage after you add days off to the company calendar and recalculate a
schedule.

n You can include new calculatedVendor YTD and Fiscal Year fields in Accounts Payable reports and forms. You use
the Fiscal Year field to specify the year for which you are running the report. The Vendor YTD field calculates amounts for
that Fiscal Year.

n In the 10-3 Scheduleswindow, you can now move tasks correctly by one day or more days when you use theGrid/Gantt
view.

n In the 10-3 Scheduleswindow, you can now move tasks correctly in the Grid/Gantt view even if neither Saturday or
Sunday is marked as off.

n In the 11-2 Work Orders/Invoices/Creditswindow, when you create queries that use the In List parameter to select
more than one client, the query results include all the specified clients.
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n Sage Construction Anywhere cost codes are now updated correctly when you change a budget cost code that included
only amaterial cost type to one that includes bothmaterial and labor.

n The 1-4 Recurring Journal window now displays an error message if you try to post multiple recurring transactions
without entering a cutoff date. The Posting Cutoff Date field now includes an asterisk to indicate that it is required.

n For 8-1-4 Equipment Management Reports, reports 22, 27, 32, and 37 that include period selection now properly
identify the year to which the selected period belongs.

n In the 10-3 Scheduleswindow, the Grid/Gantt Chart now refreshes correctly if you save days off changes to a job, and
then select a different job without first closing the 10-3 Scheduleswindow.

n In the 10-3 Scheduling window, the Scheduling Recap now displays jobs ending today.

n If you useWindows 7 andWindows Server 2008 and yourWindows Color 1 setting uses a dark color, text in highlighted
grid rows appears white, so the text is more legible against the dark background.

n If you are running Sage 100 Contractor on a Terminal Server, you no longer receive an error message saying the error
"Sage 100 Contractor 2014 has stopped working' when you start the program.

n In the 3-2 Receivable Invoices/Credits and the 4-2 Payable Invoices/Creditswindows, when you select one or more
entire rows on the grid, and then you click a different cell, highlighting in the entire rows now disappears, as expected.

n The 4-7-3 Enter Credit Card Receiptswindow now lets you save a default entry for the Credit Card field.

n In the 6-4-1 Change Orderswindow, the Period of an approved change order does not change if you save an attachment
after advancing the period.

n The 2-3-53 Dept Income Statement report now displays account names correctly.

n Accounts Receivable invoices you post using third-party programs now consistently include in the associated journal
transaction all the detail lines from the invoices.

n When you accept a default value in a cell by pressing the Enter key, the value is used only in that cell even if you had
highlighted several cells on the grid first.

n Accounts Payable invoices that include freight costs for aWIP job now post correctly to theWIP cost account, rather
than the dedicated Direct Cost Account.

n In the 12-4 Purchase Order Receiptswindow, Sage 100 Contractor now adds an extra row for sales tax when you save
a receipt with details that fill all the rows in the grid.

n Wehave added additional checks to the job removal process to ensure that when you archive a year, or when you use
the 3-5 Jobs (Accounts Receivable)window to remove jobs, you do not inadvertently remove jobs that have job costs
in the current year. The archive process does not remove a closed or refused job unless the job has: a zero balance; no
open payable invoices/credits; no job costs in the current books; no payable invoices/credits in the current books (even if
they are paid or void); and no balance in aWIP account.

Fixes for the Canadian Edition
The following issues were fixed specifically for the Canadian edition:

n Wehave reformatted the EFT files so that they are consistently accepted by Canadian banks.

n You can now run Aatrix reports for the Sample Company as if the company is registered with Aatrix.

n The 5-1-4-21, 5-1-4-22, 5-1-4-31, and 5-1-4-32 reports now display information for an employee for whom EI, PPIP, or
QPP is not computed in the payroll record. If an employee has been paid wages or has paid tax in the province, they are
included on these reports.

n In the 11-2 Work Orders/Invoices/Creditswindow, when you enter a paid amount for an invoice, the invoice balance for
the service receivables is reduced accordingly.
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n Payables created from recurring invoices are now available for payment in the 4-3-1 Invoice Selectionwindow.

n When creating standard calculations in the 5-3-1 Payroll Calculationwindow, if you select the CPP check box, the
QPP and PPIP check boxes are automatically selected.

n The 2-11-0-21 GST/HST report now includes credit card receipts that were entered without a vendor in the 4-7-3 Enter
Credit Card Receiptswindow. These transactions appear at the top of the ITC section for the period, sorted by
transactions date.

n The 1-1 Cheques/Bank Charges Equipment Costswindow now displays the correct title.

n Income taxes are now calculated correctly for hourly records that use Tax Type 16-Alimony/Maint. Payments, 18-Union
Dues, and 19-Employee RPP Contributions.
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Known Issues and Comments
The following sections describe known issues and problems in Sage 100 Contractor Version 19.3.

General

Internet Access Required for Sage 100 Contractor
Sage 100 Contractor features, such as printing or efiling tax forms, submitting enhancement requests, accessing Help, or
downloading periodic product or tax updates all require Internet access.

To take advantage of these features, ensure that any workstation or server that Sage 100 Contractor is installed on has
access to the Internet.

During installation of Sage 100 Contractor, the computer serving as the Sage license server must be able to connect to the
Internet to obtain licenses. Once installation is complete, you can check out license uses for each computer where Sage
100 Contractor is installed, then disconnect the Sage license server from the Internet.

NOTE: A static Internet connection using a compatible web browser is required for Sage Construction Anywhere.
See "Appendix A: System Requirements" for supported browsers in the Getting Started Guide at
http://help.sageconstructionanywhere.com/docs/Default.htm.

Sage Advisor Update
Sage Advisor Update is a notification and download service that alerts you when an update is available for Sage 100
Contractor. You can also use Sage Advisor Update to download updates for your Sage products.

TIP: Use theCustomize settings in theWindows system tray tomake sure you can view the Sage Advisor Update
icon and notifications from the System Tray in your Taskbar.

For more information about Sage Advisor Update, see "About Sage Advisor Update" in the User Guide and in the Sage 100
Contractor help.

Tax Forms and eFiling by Aatrix configuration requirements
Tax Forms and eFiling by Aatrix requires an Internet connection for two reasons:

l For updating forms and executable files.

l For electronic filing (eFiling) of the forms.

Both of the operations listed can report an Internet connection problem. The vast majority of these problems are a result of
problems communicating through an Internet firewall.

Firewalls need to have access allowed through specific ports:

l The Tax Forms and eFiling Updater uses standard SSL/HTTP port 80 to access the site http://updates.aatrix.com.

l The eFiling component uses secure HTTPS on port to access the site https://efile.aatrix.com.

http://help.sageconstructionanywhere.com/docs/Default.htm
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By allowing access to aatrix.com, you allow both updates and eFiling. Occasionally, restrictions are tighter and only allow
access to these ports by specific programs. Tax Forms and eFiling uses the following programs to access the Internet.

For updating using http on port 80 to http://updates.aatrix.com:

l aatrixforms.exe

l updater.exe

l updater2.exe

For eFiling using secure http on port 443 to https://efile.aatrix.com:

l builder.exe

l viewer.exe

Locating tax updates
Tax updates are released throughout the year. To get the latest information about tax updates:

1. Log on to the Customer Portal, http://na.sage.com/us/sage-construction-and-real-estate.

2. In theSolve a common problem section, click Sage Contractor Downloads and Updates.

Printing reports at year-end (U.S. Edition)
As of Version 19.2, in the U.S. Edition, if you pay retainage in the current year for a prior year invoice and then you print a 4
1 3 26 AP Aging report for the prior year, the report shows a reduced Retention amount, and the amount paid in the future
period is allocated to the Current period or an aging period, depending on the due date of the retainage and the date it was
paid.

Therefore, you should print these reports as part of your year-end processing to ensure that you have a set of reports that
reflect the true amount of retainage outstanding at year end.

TIP: If you archive your data at year end, you can also print the reports from the Archive, later.

PCI DSS Compliance
PCI DSS stands for Payment Card Industry Data Security Standard. It was developed by themajor credit card companies
as a guideline to help organizations that process card payments to prevent credit card fraud, cracking, and other security
weaknesses and threats.

A company processing, storing, or transmitting payment card datamust be PCI-compliant or risk losing its ability to
process credit card payments and being audited and/or fined. (For more information about PCI standards, see
https://www.pcisecuritystandards.org/.)

Sage 100 Contractor payment processing works exclusively with Sage Payment Solutions to enablemerchants to
seamlessly process check and credit card transactions directly in Sage 100 Contractor. The payment processing program
uses Sage Exchange, a secure payment-processing application, to connect to Sage Payment Solutions and process check
and credit card transactions.

Integrating your financial and operations system with Sage Payment Solutions lets you process check and credit card
transactions without storing your customers’ sensitive card information in your database. Sage Exchange transmits check
and credit card details through a secure connection to Sage Payment Solutions, where they are stored in a PCI-compliant
vault, protecting your from exposure to non-compliance penalties and credit card fraud.

http://www.sagecre.com/customerlogon
https://www.pcisecuritystandards.org/
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CAUTION: To avoid non-compliance with PCI standards, do not store credit card information in Sage 100
Contractor. Such storage also creates unnecessary risk for your business and your customers.

Use Adobe Reader Version 8.1.3 or later for faxing
Customers have reported problems faxing from Sage 100 Contractor with versions of Adobe Reader earlier than 8.1.3.
Adobe Reader Version 8.1.3 and later support faxing fromWindows and from Sage 100 Contractor.

IMPORTANT: To fax from Sage 100 Contractor, theWindows Fax Service component must be installed with your
Windows operating system. For more information about installing theWindows Fax Service component, see the Sage
100 Contractor Help topic, “Installing theWindows Fax Service component.”

About network configuration and TCP Remoting Channel
Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component, to enable communication
among computers on a network. By default, Sage 100 Contractor uses the TCP starting port 48750. Certain configurations
can potentially disable the communication:

l File sharing on computers running theWindows 8, Windows 7, Vista, Server 2008, Server 2008 R2, and Server 2012
operating systemmust be enabled. To enable file sharing, follow the instructions in theWindows Help.

l TCP communication requires the selection of port numbers that are not in use by other processes on the local
computer.

l Software firewalls running on the local computer can be configured to block processes from opening TCP ports,
which will prevent communication through the TCP Remoting Channel.

Sage licensing (Sage 100 Contractor Hosting Framework) cannot auto-start on
Windows 8, Windows 7 Professional, Vista, Server 2008, or Server 2008 R2
Standard
The Sage licensing service (Sage 100 Contractor Hosting Framework) cannot auto-start on computers running the
Windows 8, Windows 7 Professional, Vista Business, Server 2008, or Server 2008 R2 Standard operating systems. If the
service stops, the program displays amessage advising you to take further action to resolve this issue.

Configuring anti-virus software and third-party firewalls
During installation of the Sage 100 Contractor Hosting Framework, theWindows Firewall is configured automatically to
allow the Sage 100 Contractor Hosting Framework to act as a TCP server. If you use some other firewall, however, you
may need tomanually adjust some settings in the firewall in order to ensure proper operation.

You can use the following basic procedure tomanually configure theWindows Firewall to allow the Sage 100 Contractor
Hosting Framework to communicate with other computers. Use it as the basis for manually configuring other third-party
firewall products.

To configure the Windows Firewall:

1. ForWindows Vista or Server 2008, click Start > Control Panel > Security.

ForWindows 7, click Start > Control Panel > System and Security

ForWindows 8, click Start > All apps > Control Panel > System and Security.

2. OpenWindows Firewall, and then select Allow a program or feature through Windows Firewall.

3. If Sage 100 Contractor Hosting Framework is not on the list, you can add it by selectingAdd Program, then
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browsing to the following path:
\MB7\Programs\Sage.CRE.HostingFramework.Service-InstanceConfig.xml.

NOTE: By default, the exception is set to allow access by any computer on the network. You can refine this setting
by selecting theChange Scope button. Be aware that restricting the scope incorrectly can cause the computer to be
unable to connect with some or all of the other machines on the network.

Files to exclude when manually configuring your firewall for Windows 8 Professional 32-bit

l C:\MB7

l C:\ProgramData\Sage\Sage 100 Contractor

l C:\Program Files\Sage\Sage 100 Contractor

l C:\ProgramData\Aatrix Software

l C:\Program Files\Aatrix Software

l C:\%LocalAppData%\Sage\Sage 100 Contractor

l Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows 8 Professional 64-bit

l C:\MB7

l C:\ProgramData\Sage\Sage 100 Contractor

l C:\Program Files (x86)\Sage\Sage 100 Contractor

l C:\Program Files (x86)\Aatrix Software

l C:\ProgramData\Aatrix Software

l C:\%LocalAppData%\Sage\Sage 100 Contractor

l Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows Vista 32-bit

l C:\MB7

l C:\ProgramData\Sage\Sage 100 Contractor

l C:\Program Files\Sage\Sage 100 Contractor

l C:\ProgramData\Aatrix Software

l C:\Program Files\Aatrix Software

l C:\%LocalAppData%\Sage\Sage 100 Contractor

l Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows Vista 64-bit

l C:\MB7

l C:\ProgramData\Sage\Sage 100 Contractor

l C:\Program Files (x86)\Sage\Sage 100 Contractor
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l C:\Program Files (x86)\Aatrix Software

l C:\ProgramData\Aatrix Software

l C:\%LocalAppData%\Sage\Sage 100 Contractor

l Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows 7 Professional 32-bit

l C:\MB7

l C:\ProgramData\Sage\Sage 100 Contractor

l C:\Program Files\Sage\Sage 100 Contractor

l C:\ProgramData\Aatrix Software

l C:\Program Files\Aatrix Software

l C:\%LocalAppData%\Sage\Sage 100 Contractor

l Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows 7 Professional 64-bit

l C:\MB7

l C:\ProgramData\Sage\Sage 100 Contractor

l C:\Program Files (x86)\Sage\Sage 100 Contractor

l C:\Program Files (x86)\Aatrix Software

l C:\ProgramData\Aatrix Software

l C:\%LocalAppData%\Sage\Sage 100 Contractor

l Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows 8 Professional

l C:\MB7

l C:\ProgramData\Sage\Sage 100 Contractor

l C:\Program Files (x86)\Sage\Sage 100 Contractor

l C:\Program Files (x86)\Aatrix Software

l C:\ProgramData\Aatrix Software

l C:\%LocalAppData%\Sage\Sage 100 Contractor

l Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows Server 2008, 2011, 2012

l C:\MB7

l C:\ProgramData\Sage\Sage 100 Contractor

l C:\ProgramFiles (x86)\Sage\Sage 100 Contractor
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l C:\Program Files (x86)\Aatrix Software

l C:\ProgramData\Aatrix Software

l C:\%LocalAppData%\Sage\Sage 100 Contractor

l Network location of Sage 100 Contractor data

Configuring Windows Regional and Short Date Format:
1. Click the [Start] button, point toControl Panel, then click Clock, Language, and Region .

2. Click Region and Language.

3. On the Formats tab, select English (Canada)English (United States).

4. UnderDate and time formats, from the Short date format drop-down list, select dd/MM/yyyyMM/dd/yyyy

5. Click [OK].

6. Close theClock, Language, and Regionwindow.

Windows 8 Professional and Server 2012 Standard Operating
Systems

Windows 8 Professional and Server 2012 Standard "Sleep Mode" prevents
computers from obtaining a license use
If a computer running theWindows 8 Professional or Server 2012 Standard operating system is used as a license server,
when it goes into sleepmode other computers on the network can’t obtain a license.

To avoid this possibility, set Sleep Mode on your license server computer toNever.

To set the Sleep Mode to “Never”:

1. Start > All apps > Control Panel > System and Security > Power Options.

2. Select Change when computer sleeps.

3. From thePut computer to sleep list, select Never.

Sage licensing (Sage 100 Contractor Hosting Framework) cannot auto-start on
Windows 8
The Sage licensing service (Sage 100 Contractor Hosting Framework) cannot auto-start on computers running the
Windows 8 Professional orWindows 8 Enterprise operating systems. If the service stops, the program displays amessage
advising you to take further action to resolve this issue.

Solution for Server 2012 error message about mb7.kpr file
If you encounter an error message about opening themb7.kpr file when launching Sage 100 Contractor on a computer
runningWindows Server 2012, follow these steps to resolve the issue:

1 On theWindow desktop, right-click Start, and then click [Explore].

2 On the left side of the window, under Folders, right-click theMB7 folder, and then select Properties.
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3 On theMB7 Propertieswindow, click the [Security] tab.

4 From the list underGroup or User Names, select USERS, then click the [Edit] button.

5 On thePermissionswindow, select USERS again, and underAllow, select the Full control check box.
Selecting Full control, selects all the check boxes necessary for this solution.

6 On thePermissionswindow, click [OK], and then on theMB7 Propertieswindow, click [OK].

Server 2012 network configuration and TCP Remoting Channel
Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component to enable communication
among computers on a network. File and printer sharing on computers running the Server 2012 operating systemmust be
enabled. To enable file sharing, follow the instructions in theWindows Server 2012 Help.

Windows 7 Professional and Server 2008 R2 Standard Operating
Systems

Launching Sage 100 Contractor to run as administrator for scheduling reports

IMPORTANT: On computers runningWindows 7 Professional or Server 2008 R2 Standard, scheduling Sage 100
Contractor reports requires that you “run as administrator” or to “run the program as administrator.”

Microsoft Windows has changed security rules in theWindows 7 Professional and Server 2008 R2 Standard operating
systems tomake your computer more secure. If you are running Sage 100 Contractor as a typical user, then you have
limited privileges in some areas of the program, such as saving a report schedule. To save a report schedule, youmust
launch Sage 100 Contractor with the command to eitherRun as administrator orRun this program as an
administrator.

When you select either command, the settings are limited to you personally. Your settings to run Sage 100 Contractor as
administrator do not affect the next person who logs on and launches Sage 100 Contractor from this computer. Your
settings on this computer can either be temporary or persistent. For example, when you select Run as administrator, you
run the program as administrator for that session only. When you select Run this program as an administrator, you set
program properties to always run the program as administrator when you log on to this computer.

NOTE: "Run as administrator" and "Run this program as an administrator" are not related toWindows 7
Professional or Server 2008 R2 Standard operating systems user groups but are limited to a specific program you are
running.

To set "Run as administrator":
1 On yourWindows desktop, right-click the Sage 100 Contractor program icon.

2 From the drop-downmenu, to launch the program, click [Run as administrator].

NOTE: SelectingRun as administrator only runs the current session of running Sage 100 Contractor. The setting
does not persist after the session is over.

To set "Run this program as an administrator":
1 On yourWindows desktop, right-click the Sage 100 Contractor program icon.

2 From the drop-downmenu, click [Properties].

3 On the Sage 100 Contractor Properties window, click the [Compatibility] tab.

4 Under Privileges Level, select Run this program as an administrator.
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5 Click [Apply], and then click [OK].

NOTE: SelectingRun this program as an administrator always runs the program with these properties when you
launch the program on this computer. The setting persists.

Windows 7 Professional, Windows 8 Professional, and Server 2008 R2 Standard
"Sleep Mode" prevents computers from obtaining a license use
If a computer running theWindows 7 Professional, Windows 8, or Server 2008 R2 Standard operating system is used as a
license server, when it goes into sleepmode other computers on the network can’t obtain a license.

Set Sleep Mode on your license server computer toNever.

To set the Sleep Mode to “Never”:

1. Start > Control Panel > System and Security > Power Options.

2. Select Change when computer sleeps.

3. From thePut computer to sleep list, select Never.

Windows Server 2008 R2 and Microsoft .NET 3.5.1
Microsoft .NET 3.5.1 must be available and enabled prior to installing Sage 100 Contractor on aWindows Server 2008 R2
machine. Server 2008 R2 comes with .NET 3.5.1 loaded but not installed, so Sage 100 Contractor doesn’t install it
automatically.

If you attempt to install Sage 100 Contractor without .NET 3.5.1 installed, you will receive the followingmessage during the
licensing install: “Sage.CRE.HostingFramework.Service v3.2 has stopped working.”When you click [OK], the installation
continues, but the services have not been installed so Sage 100 Contractor cannot open. The
Sage.CRE.HostingFramework Service will not install unless .NET 3.5.1 has been installed. If you receive the above
message during installation, install .NET Framework 3.5.1 and reinstall Sage 100 Contractor.

To verify that .NET 3.5.1 is installed on Windows Server 2008 R2:
1 Click theStart button in the lower left corner of the display.

2 Highlight Administrative Tools and select Server Manager.

3 In theServer Manager interface, click Features to display all the installed Features in the right-hand pane. Verify that
.NET Framework 3.5.1 is listed.

To enable .NET 3.5.1 on Windows Server 2008 R2:
1 In theServer Manager interface, select Add Features to display a list of possible features.

2 In theSelect Features interface, expand .NET Framework 3.5.1 Features.

3 Once you expand .NET Framework 3.5.1 Features, you will see two check boxes. Check the box next to .NET
Framework 3.5.1 and click Next.

4 In theConfirm Installation Selections interface, review the selections and then click [Install].

5 Allow the installation process to complete and then click [Close].

NOTE: Enabling .NET Framework 3.5.1may require a reboot.
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Solution for Server 2008 R2 "Permission Error Opening File"
If you see a permission error message when launching Sage 100 Contractor on a computer running theWindows Server
2008 R2 operating system, follow these instructions:

1 On theWindow desktop, right-click Start, and then click Open Windows Explorer.

2 On the left side of the window, underComputer > Local Disk, right-click the \MB7 folder, and then select Properties.

3 On theMB7 Propertieswindow, click theSecurity tab.

4 From the list underGroup or User Names, select USERS, and then click theEdit button.

5 On thePermissionswindow, select USERS again, and underAllow, select the Full control check box.

6 Selecting Full control selects all the check boxes necessary for this solution.

7 On thePermissionswindow, click OK, and then on theMB7 Propertieswindow, click [OK].

Solution for Windows 2008 Server R2 Application Error Message
Under some circumstances, on servers operatingWindows 2008 Server R2, youmay experience the following error
message when trying to open a photograph or image file in Sage 100 Contractor:

"No application is associated with the specific file associated with this application."

This error message appears when you attempt to open an image file in Sage 100 Contractor but you have not yet enabled
the Desktop Experience feature inWindows 2008 Server R2. If you receive this error message, install Desktop Experience
using the Server Manager utility:

1 InWindows 2008 Server R2, select Start > All Programs > Administrative Tools > Server Manager.

2 In theServer Managerwindow, click Features (left-hand pane).

3 In the Features pane, click Add Features.

4 Select the Desktop Experience check box.

5 If you are prompted to add additional features, click [Add Required Features].

6 Click [Next].

7 Click [Install].

Windows Vista and Server 2008 Operating Systems

Solution for Server 2008 "Permission Error Opening File"
If you see a permission error message when launching Sage 100 Contractor on a computer running theWindows Server
2008 operating system, follow these instructions:

1 On theWindow desktop, right-click Start, and then click [Explore].

2 On the left side of the window, under Folders, right-click the \MB7 folder, and then select Properties.

3 On theMB7 Propertieswindow, click theSecurity tab.

4 From the list underGroup or User Names, select USERS, then click the [Edit] button.

5 On thePermissionswindow, select USERS again, and underAllow, select the Full control check box. Selecting Full
control selects all the check boxes necessary for this solution.

6 On thePermissionswindow, click [OK], and then on theMB7 Propertieswindow, click [OK].
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Vista and Server 2008 “Sleep Mode” prevents computers from obtaining a license
use
If you are using a Vista or Server 2008 computer as the Sage license server and it goes intoSleep Mode, the workstations
cannot obtain a license use.

Use a different computer on your network to be the Sage license server. Any supported operating system can be used in
place of Vista or Server 2008.

Set Sleep Mode on your license server computer toNever.

To set the Sleep Mode to "Never":
1 Start > Control Panel > System and Maintenance > Power Options.

2 Select Change when computer sleeps.

3 From thePut computer to sleep list, select Never.

Vista, Windows 7, and Server 2008 and changing the Sage License Server
computer
On a Vista, Windows 7, or Server 2008 workstation, when you select File > Change Sage License Server > Select the
computer from the list of computers on your network, the commandmay fail to generate a list of network computer
names. To resolve this issue, click Enter the IP address or name of the computer, and then type the IP address of the
server computer in the box.

Possible conflict when running scheduled reports on Vista Business 64-bit
operating system
On computers running the Vista Business operating system, the Sage 100 Contractor report scheduler may encounter a
conflict with theMicrosoft print spooler (splwow.exe) andmay not function as expected.

A solution for avoiding this possible conflict would be to schedule reports on computers running a 32-bit operating system.
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